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1 Presentazione 
Si tratta di un programma concepito per il dimensionamento e la verifica di paratie 

generiche, realizzate in calcestruzzo armato o in qualsiasi materiale, che comprende anche 

il dimensionamento delle armature.  

Dispone di un assistente che aiuta l’utente a inserire i dati per i casi comuni di edifici con 

più piani interrati e di un altro semplice assistente per edifici con uno o due piani interrati. 

 

 
 

2 Relazione di calcolo 

2.1 Modello di calcolo 

Il modello di calcolo impiegato è rappresentato da un’asta verticale, le cui proprietà 

meccaniche si ottengono per metro trasversale di parete. Su quest’ultima agiscono: il ter- 

reno (sia all’intradosso che all’estradosso), i carichi sul terreno, gli elementi di sostegno 

laterale quali puntelli, ancoraggi attivi, ancoraggi passivi, o elementi costruttivi quali solai e 

i carichi applicati sulla sommità della parete. 

L’inserimento di elementi di sostegno laterale (puntelli, ancoraggi attivi e ancoraggi passivi) 

comporta la nascita di condizioni al contorno sul muro, che si materializzano at-traverso 

molle di rigidezza pari alla rigidezza assiale dell’elemento. 

Quando si definisce uno strato roccioso, il programma considera che la parete è incastrata 

se penetra al suo interno di una lunghezza uguale o maggiore a due volte lo spessore della 

parete stessa. Per valori compresi tra 20 cm e due volte lo spessore della parete, si 

considera che quest’ultima è semplicemente appoggiata sullo strato roccioso, cioè, che può 

ruotare ma non traslare. 

Molto importante 

Il programma esegue il calcolo di paratie considerandole come elementi strutturali 

sottoposti a spinte laterali esercitate dal terreno e a carichi esterni applicati su di essi.  

Non esegue le verifiche geotecniche, quali quelle consistenti nella determinazione della 

resistenza al piede, della resistenza all’attrito laterale, al sifonamento, ecc., che devono 

essere oggetto di uno studio complementare a partire dalla relazione geotecnica. La 

stessa cosa vale per elementi quali puntelli, tipo di ancoraggio, il loro diametro, la 

lunghezza di ancoraggio ecc., che richiedono uno studio separato. 
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La discretizzazione della parete si esegue ogni 25 cm, in modo tale da ottenere in ciascun 

punto il diagramma di comportamento del terreno. Inoltre, il modello comprende anche i 

punti in corrispondenza dei quali si dispongono le coazioni laterali. 

2.2 Spinte 

Le spinte esercitate dal terreno sulla parete dipendono dagli spostamenti di quest’ultima. 

Per tenere in considerazione questa interazione, si utilizzano dei diagrammi di 

comportamento del terreno quali quello mostrato nella seguente figura: 

 

 Fig. 1 

I punti significativi nel diagramma, ea, ep ed eo, sono noti, rispettivamente, come spinta 

attiva, spinta passiva e spinta a riposo. Gli spostamenti limite attivo e passivo si rap- 

presentano mediante a e p e il loro valore si ricava a partire dai moduli di sottofondo 

attivo e passivo (coefficienti di Winkler) inseriti dall’utente. 

Il programma calcola i coefficienti di spinta del terreno sulla base delle formule seguenti: 

 Spinta a riposo: formula di Jaky 

 Spinta attiva: formula di Coulomb 

 Spinta passiva: formula di Rankine 

È possibile ottenere ulteriori informazioni circa il calcolo di queste spinte consultando 

l’opzione Elementi di sostegno - Calcolo delle spinte contenuta nell’Help ubicato nella 

barra degli strumenti. 

I valori del modulo di sottofondo, così come quelli di qualsiasi altro parametro geotecnico, 

sono di difficile valutazione. Il programma fornisce dei valori orientativi relativi ad alcuni 
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tipi di terreni; tuttavia si raccomanda di ricorrere alla letteratura specializzata e a dati 

empirici per disporre di valori maggiormente precisi. Normalmente, se è stato eseguito uno 

studio geotecnico, quest’ultimo deve fornire il valore esatto di tale parametro. 

I moduli di sottofondo rappresentano la rigidezza del terreno in corrispondenza di un 

determinato punto, che a sua volta può variare a seconda del verso dello spostamento. 

Inoltre, dato che la rigidezza del terreno tende ad aumentare con la profondità, si può 

considerare una variazione lineare della stessa che l’utente definisce attraverso un 

parametro noto come gradiente del modulo di sottofondo, coincidente con l’incremento di 

tale modulo per metro di profondità. 

Nel diagramma che segue, si ipotizza che il terreno si comporti plasticamente, in modo tale 

che il diagramma stesso si aggiorni tra una fase e la successiva. La figura sottostante 

illustra questo concetto (pre rappresenta lo spostamento della fase precedente). 

 

Fig. 2 

Se la parete continua a spostarsi verso destra, si ottiene un punto che si muove lungo la 

curva di carico, mentre se cambia il verso del suo spostamento, la spinta varierà lungo la 

curva di scarico passante per il punto iniziale. 

In corrispondenza dei punti della parete in cui è presente il terreno sia all’intradosso che 

all’estradosso, il diagramma di comportamento adottato si ottiene sommando i diagrammi 

corrispondenti alla profondità su entrambi i lati della parete: 

 

Fig. 3 
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2.2.1 Calcolo sismico 

L’azione sismica comporta che le spinte generate sulla parete aumentino transitoriamente. 

La spinta attiva in condizioni sismiche è maggiore di quella corrispondente alla situazione 

statica. 

Analogamente, la spinta passiva esercitata dalla parete sul terreno può ridursi 

considerevolmente durante eventi sismici. Per la valutazione di entrambe le spinte, il 

programma adotta un metodo pseudostatico con i coefficienti di spinta dinamici basati 

sulle equazioni di Mononobe-Okabe. È possibile ottenere maggiori informazioni 

consultando l’opzione Elementi di sostegno - Calcolo delle spinte contenuta nell’Help 

ubicato nella barra degli strumenti. 

Nei risultati relativi a ciascuna fase costruttiva, si mostrano due grafici: il primo senza 

azione sismica e il secondo con azione sismica. 

Analogamente, negli elenchi delle azioni interne, nei risultati relativi a elementi di 

ancoraggio, ecc., compaiono entrambi i casi. 

2.2.2 Verifiche di stabilità 

Rapporto tra il momento stabilizzante della spinta passiva e il momento 

destabilizzante della spinta attiva all’estradosso 

Nel menu Progetto > Opzioni è possibile definire i coefficienti di sicurezza per eseguire la 

verifica di stabilità: 

 

Fig. 4 



 

 

 

StruBIM Embedded Walls  /  7 

Tra di essi è presente un coefficiente che rappresenta, per ciascuna fase costruttiva, il 

rapporto tra il momento stabilizzante prodotto dalla spinta passiva all’intradosso e il 

momento destabilizzante originato dalla spinta attiva all’estradosso. Entrambi questi 

momenti si calcolano rispetto alla quota di fondo della paratia, nel momento in cui 

quest’ultima sia a sbalzo, o rispetto alla quota dell’appoggio, nel caso in cui esso sia unico. 

Se sono presenti più appoggi, la paratia è equilibrata e non è necessario calcolare tale 

coefficiente. 

È possibile definire coefficienti differenti per le verifiche con sisma e per quelle senza 

sisma. 

Il programma mostra i risultati relativi a ciascuna fase negli elenchi delle Verifiche di 

stabilità (Coefficienti di sicurezza). È possibile accedere ad essi cliccando sul bottone 

Elenchi del progetto, ubicato nella parte destra della barra degli strumenti. Tali dati si 

includono inoltre negli elenchi che il programma consente di visualizzare e di stampare 

dopo aver selezionato l’opzione Verificare del menu Calcolo. Si ricorda nuovamente che 

se esistono più appoggi, la paratia è equilibrata e non è necessario calcolare il coefficiente 

di sicurezza al ribaltamento. Per tale motivo negli elenchi relativi alle fasi in cui è presente 

più di un appoggio compare il testo “Non procede”. 

 

Fig. 5 

Riserva di sicurezza della spinta passiva all’intradosso 

È possibile definire i coefficienti di sicurezza nel menu Progetto > Opzioni. 
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Fig. 6 

È possibile definire coefficienti differenti per le verifiche con sisma e per quelle senza 

sisma. 

Il programma mostra i risultati relativi a ciascuna fase costruttiva negli elenchi delle 

Verifiche di stabilità (Coefficienti di sicurezza). È possibile accedere ad essi cliccando sul 

bottone Elenchi del progetto, ubicato nella parte destra della barra degli strumenti. Tali 

dati si includono inoltre negli elenchi che il programma consente di visualizzare e di 

stampare dopo aver selezionato l’opzione Verificare del menu Calcolo. Si ricorda 

nuovamente che se esistono più appoggi, la paratia è equilibrata e non è necessario 

calcolare il coefficiente di sicurezza al ribaltamento. Per tale motivo negli elenchi relativi 

alle fasi in cui è presente più di un appoggio compare il testo “Non procede”. 

 

Fig. 7 
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Verifica di stabilità globale 

Il programma è in grado di analizzare la stabilità globale mediante l’ottenimento della 

superficie di scivolamento circolare più sfavorevole. È possibile consultarla sullo schermo 

(nella fase costruttiva che si sta visualizzando) mediante l’opzione Superficie di 

scivolamento circolare più sfavorevole ubicata nel menu Calcolo (Fig. 8). 

La verifica della superficie di scivolamento circolare più sfavorevole si esegue nelle fasi in 

cui non esiste ancora nessun solaio costruito; nelle fasi in cui i solai diventano operativi si 

ipotizza che la costruzione realizzata fino a quel momento impedisca lo sviluppo di tale 

superficie di scivolamento. I relativi risultati compaiono nell’elenco delle Verifiche di 

stabilità (Superficie di scivolamento circolare più sfavorevole). È inoltre possibile 

accedere a tale elenco cliccando sul bottone Elenchi del progetto ubicato nella parte 

destra della barra degli strumenti. 

 

Fig. 8 

Tali dati sono inoltre compresi negli elenchi che il programma consente di visualizzare e di 

stampare dopo aver cliccato sull’opzione Verificare del menu Calcolo. 

Nel menu Progetto > Opzioni si possono indicare i coefficienti di sicurezza per la verifica 

della superficie di scivolamento circolare. È possibile definire coefficienti differenti per le 

verifiche con sisma e per quelle senza sisma. 

 

Si possono ottenere ulteriori informazioni consultando l’opzione Elementi di sostegno - 

Calcolo delle spinte contenuta nell’Help ubicato nella barra degli strumenti. 
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2.3 Verifiche dell’armatura 

Il procedimento di verifica delle prescrizioni relative all’armatura previste dalla norma 

consiste nel verificare in primo luogo i criteri geometrici e di resistenza relativi all’armatura 

orizzontale e verticale e, successivamente, gli irrigidimenti. 

I criteri geometrici consistono in limiti relativi al copriferro, all’interferro e ai rapporti di 

armatura minimo e massimo. I criteri di resistenza consistono in requisiti da soddisfare per 

il taglio, per la flessocompressione, per i rapporti meccanici di armatura e per le lunghezze 

di sovrapposizione. Si consiglia di consultare gli elenchi delle verifiche previste dalla norma 

e i corrispondenti articoli nella norma stessa per ottenere maggiori informazioni. 

Per quanto concerne le verifiche di resistenza, il programma stabilisce che le sezioni si 

debbano verificare ogni metro; in ognuna di esse, le azioni interne di progetto si ottengono 

sulla base dei risultati relativi a ciascuna fase e conformemente ai casi seguenti: 

 C1: Azione assiale, taglio e momento flettente, moltiplicati per il coefficiente di 

amplificazione. 

 C2: Azione assiale nulla, taglio e momento flettente moltiplicati per il coefficiente di 

amplificazione. 

Per quanto riguarda le verifiche agli stati limite ultimi, si applica il coefficiente di 

amplificazione al carico inserito dall’utente, il cui valore varia a seconda che ci si trovi in 

fase di costruzione o in fase di servizio. Per le verifiche agli stati 

limite di esercizio (fessurazione) i coefficienti di amplificazione si assumono uguali all’unità. 

Le azioni interne si calcolano sempre per pannello e le verifiche previste dalla norma si 

eseguono assumendo come area resistente dello stesso quella indicata nella figura 

sottostante: 

 

Fig. 9 
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2.3.1 Verifica a flessocompressione 

La verifica della resistenza della sezione (resistenza di progetto) viene eseguita assumendo 

una legge costitutiva sforzi-deformazioni rappresentata dallo stress-block. Sulla base di 

questo principio, il programma è in grado di distinguere sezioni fessurate in calcestruzzo, a 

causa della combinazione delle azioni interne, da sezioni prive di fessurazioni. 

La verifica a flessocompressione è implementata per tutte le norme contenute nel 

programma, con le rispettive peculiarità inerenti alle formulazioni di compatibilità e alle 

deformazioni consentite per il materiale costituente la sezione (acciaio e calcestruzzo). 

Il programma verifica inoltre che l’armatura sia correttamente ancorata, in modo tale da 

poterla considerare nel calcolo a flessocompressione. 

2.3.2 Verifica a taglio 

Analogamente alla verifica a flessocompressione, la verifica di questo stato limite ultimo si 

esegue in corrispondenza di differenti quote della paratia. Dato che quest’ultima non 

presenta armatura trasversale, si considerano unicamente i contributi forniti dal 

calcestruzzo e dall’armatura longitudinale alla resistenza a taglio. 

Il contributo del calcestruzzo alla resistenza a taglio si esprime mediante il termine Vcu, 

ricavabile sperimentalmente. Esso è funzione della resistenza del calcestruzzo e della 

larghezza e altezza utile della sezione. 

2.3.3 Verifica per gli irrigidimenti orizzontali 

Il programma verifica che il diametro degli irrigidimenti sia almeno uguale a quello 

dell’armatura base, che essi siano uniformemente distribuiti lungo l’intera altezza della 

parete, e che l’interferro sia uguale o minore a 2.5 m. 

Questi criteri sono stati dedotti dalle NTE (Norme Tecnologiche dell’Edilizia, Spagna), 

Preparazione del terreno, Fondazioni. 

2.3.4 Verifica per gli irrigidimenti verticali 

Si eseguono le stesse verifiche condotte per gli irrigidimenti orizzontali, ma l’interferro degli 

irrigidimenti verticali deve essere uguale o inferiore a 1.5 m. 



 

 

 

StruBIM Embedded Walls  /  12 

2.4 Dimensionamento dell’armatura 

2.4.1 Dimensionamento dell’armatura verticale 

Della totalità delle voci presenti nella tabella di armatura, si seleziona la più economica tra 

tutte quelle che soddisfano i requisiti della norma relativi alla resistenza, ai rapporti di 

armatura, all’interferro, ecc. L’armatura base, oltre a dover soddisfare i criteri minimi 

relativi all’interferro e al rapporto di armatura, deve assorbire almeno il 50% del momento 

massimo. Nelle zone in cui l’armatura base non soddisfa le verifiche a flessocompressione 

e di fessurazione, si dispongono rinforzi. 

Nel caso in cui le lunghezze delle barre siano maggiori rispetto a quelle inserite dall’utente, 

si generano le lunghezze di sovrapposizione richieste. 

2.4.2 Dimensionamento dell’armatura orizzontale 

Della totalità delle voci presenti nella tabella di armatura, il programma seleziona la più 

economica tra tutte quelle che soddisfano i criteri relativi all’interferro e al rapporto di 

armatura descritti precedentemente al paragrafo 1.3. 

2.4.3 Dimensionamento degli irrigidimenti 

Il diametro dell’irrigidimento, sia verticale che orizzontale, deve essere uguale o maggiore 

del più grande diametro usato sia all’intradosso che all’estradosso. Si fornisce un 

determinato numero di barre in modo tale che l’interferro degli irrigidimenti orizzontali sia 

al massimo pari a 2.5 m, e a 1.5 m per gli irrigidimenti verticali. 

2.5 Dimensionamento di paratie di pali in 

calcestruzzo 

Per quanto concerne il dimensionamento di paratie di pali in calcestruzzo, si segue lo 

stesso procedimento adottato per i muri di sostegno. Relativamente all’armatura (ad ec-

cezione degli irrigidimenti, che non si usano in questo tipo di paratie), si eseguono tutte le 

verifiche previste dalla norma elencate al paragrafo 2.4 di questo manuale. 
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2.6 Dimensionamento di paratie di palancole in 

acciaio con profilati generici 

Una volta scelti una serie e un profilato al suo interno, è possibile proseguire con il 

dimensionamento. Nel caso in cui il profilato non soddisfi i requisiti relativi alla resistenza, 

il programma dispone il profilato successivo della serie ed esegue nuovamente il calcolo 

del muro, dato che cambiando il profilato cambiano le azioni interne. In seguito, si esegue 

nuovamente la verifica e, se il nuovo profilato non la soddisfa, si ripete il processo fino ad 

incontrarne uno che la soddisfi. 

Le verifiche condotte su questo tipo di paratie sono le seguenti: 

2.6.1 Tensione con amplificazione per snellezza 

Tensione di Von Mises calcolata a partire dallo sforzo normale (funzione dell’azione assiale, 

del fattore di lunghezza efficace dovuto alla snellezza, del momento flettente e del modulo 

di resistenza della sezione) e tangenziale (funzione del taglio e dell’area resistente a taglio). 

2.6.2 Tensione con eccentricità del carico in sommità della 

paratia 

In questo caso, al posto di moltiplicare l’azione assiale per il fattore di lunghezza efficace 

come nel caso precedente, il programma considera un momento aggiuntivo calcolato 

come il prodotto tra l’azione assiale in sommità della paratia e la massima eccentricità 

prodotta dalla deformazione della stessa. 

2.6.3 Snellezza 

La snellezza non deve essere maggiore del valore raccomandato dalla norma nel momento 

in cui l’elemento sia soggetto ad azioni di compressione. 

 

2.7 Dimensionamento di paratie di micropali 

I micropali sono elementi a sezione cilindrica, conficcati nel terreno in situ, armati con tubi 

in acciaio e rinforzati tramite iniezione di boiacca o malta cementizia, i cui diametri non 

eccedono abitualmente i 30 cm. L’utente può definire il diametro esterno o il diametro 

dello scavo, e il programma seleziona il tubo in acciaio a sezione cilindrica tra tutti quelli 

definiti nella biblioteca. Il dimensionamento dei micropali si esegue a flessocompressione; 
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per la verifica agli stati limite ultimi della sezione in calcestruzzo armato, il programma usa 

il diagramma parabola-rettangolo, con i corrispondenti diagrammi sforzo-deformazione 

per l’acciaio e per il calcestruzzo. A partire dalla serie del profilato scelto per il progetto, si 

verificano in maniera sequenziale crescente tutti i profilati appartenenti alla serie in 

questione. Si stabilisce la compatibilità tra azioni interne e deformazioni e si verifica che 

non si ec-cedano né gli sforzi nel calcestruzzo e nell’acciaio né i loro limiti di deformazione. 

Si considera un’eccentricità minima o accidentale, così come un’eccentricità aggiuntiva 

dovuta a instabilità prevista dalla norma, limitando il valore della snellezza meccanica, sulla 

base di quanto indicato nella norma stessa. 

La lunghezza libera di inflessione considerata corrisponde alla lunghezza libera in ogni 

fase, tenendo in considerazione che si ipotizza che la parte completamente interrata non 

possa subire il fenomeno dell’instabilità piana, oppure alla distanza tra punti in cui il 

momento è nullo (in presenza di solai, puntelli, ecc., che producono inflessioni nel 

diagramma del momento flettente). 

Il diametro massimo del tubo a sezione circolare è limitato al diametro del micropalo. 
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3 Descrizione del programma 

 

Fig. 10 

3.1 Assistenti 

Quando si crea un nuovo progetto, si apre il dialogo Nuovo Progetto. 

 

Fig. 11 

Se l’utente crea un nuovo progetto mediante un assistente, a seconda del tipo di assistente 

selezionato il programma genera i dati necessari a descriverlo a partire da un numero 

ridotto di parametri inseriti in maniera sequenziale. “Paratie” comprende la generazione del 

processo costruttivo e del predimensionamento della geometria di una paratia in 
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calcestruzzo armato, scavata per fasi con puntellamenti successivi (temporanei o 

permanenti), che sostiene più solai posti a quote differenti, e contempla la possibilità che 

esistano edifici contigui. Crea inoltre una fase di servizio finale in cui la paratia è in grado di 

resistere al carico dell’edificio in corrispondenza della sua sommità. È possibile control-lare 

e/o modificare qualsiasi dato una volta generato il progetto. 

In fase di predimensionamento, lo spessore della paratia è pari a H/20 (dove H è la 

profondità dello scavo), con un minimo di 45 cm e un massimo di 100 cm. Si generano 

arrotondamenti a valori pari a 45, 60, 80 e 100 cm. 

L’altezza totale della paratia varia tra 2H e 1.4H, a seconda che nello scavo siano o meno 

stati inseriti puntellamenti. In funzione del numero di fasi da scavare, si assume un valore 

intermedio appartenente al range precedente. Se è presente un ammasso roccioso a 

scarsa profondità, la paratia si interra nello strato per una profondità pari a 

20 cm, valore minimo per poterla considerare semplicemente appoggiata su quel punto. 

Si consiglia di leggere attentamente gli help in ciascun dialogo dell’assistente per conoscere 

e comprendere le approssimazioni effettuate. 

Esistono due tipi di assistenti: 

 

3.1.1 Assistente 1. Paratie in calcestruzzo armato per 

edifici 

Si tratta di un assistente per la generazione di paratie con più livelli. Compare una serie di 

finestre in cui l’utente deve inserire dei dati le cui opzioni dispongono di help su schermo. 

Prima di proseguire, è necessario evidenziare che quando si parla di quota bisogna inserire 

il segno negativo, dato che si assume come quota 0 quella del livello superiore del terreno. 

Dati generali 

Bisogna indicare la profondità totale dello scavo. 

 

Fig. 12 
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Terreno 

Esiste la possibilità di definire il livello freatico, l’ammasso roccioso, e il sovraccarico sul 

terreno all’estradosso. Inoltre, si devono configurare i differenti strati del terreno da 

contenere. 

 

Fig. 13 

Fasi intermedie di scavo 

Bisogna specificare il numero di fasi dello scavo in cui si dispongono ancoraggi, e in 

ciascuna di esse si deve indicare la loro quota e il tipo di ancoraggio (puntello, ancoraggio 

attivo permanente o provvisorio, ancoraggio passivo permanente o provvisorio). Bisogna 

inoltre definire la quota alla quale si dispone l’ancoraggio.  

Per ciascuna fase di scavo, l’assistente genera 2 fasi: la prima consiste nello scavo del 

terreno e la seconda nella disposizione dell’ancoraggio. Le quote delle fasi di scavo non 

possono essere maggiori, in valore assoluto, della profondità di scavo indicata nella prima 

finestra dell’assistente, Dati generali. Se, ad esempio, la profondità totale dello scavo è 

pari a 9 m e le sue fasi sono pari a 3 m, in questa sede bisogna unicamente definire due 

fasi: la prima, a -3 m, e la seconda, a -6 m. Il programma genera automaticamente l’ultima 

fase della scavo senza la fase di ancoraggio. 

 

Fig. 14 
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Solai (fasi di costruzione) 

Si tratta di una lista dei solai e della fondazione (se quest’ultima esercita un effetto di 

controventamento) che indica la loro quota superiore, la loro altezza e il taglio (espresso in 

kN/m) cui sono sottoposti in fase di costruzione. Inoltre, è possibile definire il solaio e la 

piastra di fondazione. La differenza tra la quota superiore della piastra e la sua altezza 

deve coincidere con la quota di fondo dello scavo; in questo caso: -13.50 - 0.80 = -14.30. 

 

Fig. 15 

Fase di servizio (opera terminata) 

In questo riquadro di dialogo si devono specificare i carichi in sommità della paratia e i tagli 

in fase di servizio che i solai dei piani interrati trasmettono alla stessa. 

 

Fig. 16 
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3.1.2 Assistente 2. Paratie in calcestruzzo armato per 

edifici con uno o due piani interrati 

 

Fig. 17 

Analogamente all’assistente precedente, compaiono schermate sequenziali finalizzate 

all’inserimento dei dati che definiranno il nuovo progetto. 

 

Edificio 

Di default, è previsto un unico piano interrato; se si attiva la casella “Altezza libera del piano 

interrato inferiore (h2)” è possibile inserire un ulteriore piano interrato. Bisogna indicare le 

altezze libere tra i solai, le luci trasversali (luce libera dei solai compresa tra la paratia e 

l’appoggio successivo; tramite questo dato il programma genera in modo approssimato le 

altezze dei solai e i carichi che gli stessi trasmettono alla paratia). Se l’edificio si appoggia 

sulla trave di coronamento della paratia, si deve indicare il numero di piani al di sopra del 

livello del terreno e, infine, il tipo di fondazione. Mediante quest’ultimo dato, si informa 

l’assistente circa la tipologia di fondazione presentata dall’edificio. 

 

Fig. 18 
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Edifici contigui 

In tale riquadro di dialogo si definisce il tipo di edificio contiguo (senza edifici contigui, 

carreggiata con traffico leg-gero, carreggiata con traffico pesante o edificio contiguo; se si 

seleziona quest’ultima opzione, bisogna indicare il numero di piani totali dell’edificio e la 

profondità del piano di fondazione). A seconda della casella che si spunta, si applica un 

carico superficiale sul terreno all’estradosso. 

 

Fig. 19 

Terreno 

Si ammettono al massimo due strati. È inoltre possibile definire la presenza di un ammasso 

roccioso e del livello freatico, dovendo indicare le loro rispettive profondità. 

 

Fig. 20 

Informazione 

Prima di creare il progetto, compare una finestra in cui si mostra un elenco con i dati 

appena definiti; una volta creato il progetto, è possibile eseguire cambi e/o modifiche 

relativamente ai dati inseriti. L’elenco può essere stampato, o può essere esportato in 

formato HTML, PDF, TXT, RTF e DOCX. 
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Fig. 21 

3.2 Modalità di lavoro 

Si raccomanda di seguire i passi seguenti: 

1. Creare un file Nuovo con il nome del progetto. 

2.  Selezionare il tipo di assistente oppure Nessuno. In quest’ultimo caso si devono creare 

manualmente le fasi costruttive tramite il bottone Selezione e indicare i dati necessari 

relativi a ciascuna di esse: profondità dello scavo, ancoraggi, ecc. 

3.  Controllare i dati inseriti in ogni fase. 

4. Calcolare e consultare le azioni interne ottenute in ciascuna fase cliccando sul bottone 

Azioni interne. 

5. Se la paratia è realizzata in calcestruzzo armato, per ricavare le armature bisogna 

cliccare sul bottone Dimensionare. 

6. Consultare gli elenchi contenenti le verifiche eseguite mediante il bottone Verificare. 

7. Modificare le armature, tramite il bottone Modifica armatura, e per controllarle 

utilizzare il bottone Verificare. 

8. Ottenere elenchi e disegni esecutivi attraverso i bottoni Elenchi del progetto e Disegni 

esecutivi del progetto. 
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3.3 Menu del programma 

I menu e i dialoghi del programma che si aprono quando si eseguono alcune opzioni 

contengono un help su schermo, cui è possibile accedere in tre modi distinti: 

3.3.1 Tasto F1 

Per ottenere help circa un’opzione del menu, bisogna posizionare il cursore al di sopra 

della stessa e, senza cliccare su di essa, premere il tasto F1. 

3.3.2 Icona con il simbolo del punto interrogativo 

Nella barra del menu della finestra principale del programma si trova un’icona con il 

simbolo del punto interrogativo. È possibile ottenere help circa una specifica opzione del 

programma cliccando su tale icona, aprendo l’opzione desiderata del menu, posizionando 

il cursore sul comando di cui desidera ottenere help e cliccando quindi su di esso. Una 

volta terminata tale procedura, compare una finestra con l’help desiderato. 

Per disattivare questo tipo di help, è possibile seguire una tra le procedure che seguono: 

cliccare il tasto destro del mouse, cliccare sull’icona con il simbolo del punto interrogativo, 

o premere il tasto Esc. È inoltre possibile ricevere assistenza cliccando sulle icone della 

barra degli strumenti. A tale scopo, si clicchi sull’icona con il simbolo del punto 

interrogativo. Una volta che ci si è posizionati con il cursore del mouse sulle icone, le stesse 

saranno delimitate da un contorno blu che indica che l’help è attivo. In seguito, bisogna 

cliccare sull’icona desiderata per aprire la finestra di help corrispondente. 

Nella barra del titolo dei dialoghi che si aprono quando si seleziona un’opzione del 

programma è inoltre presente un’icona con il simbolo del punto interrogativo. Quando si 

clicca su di essa e si sfogliano le finestre di dialogo, le opzioni contenenti l’help si 

evidenziano in blu. Per aprire la finestra di help bisogna cliccare su queste opzioni. 

3.3.3 Guida rápida 

L’informazione correlata alle opzioni del menu può essere visualizzata e stampata 

selezionando l’opzione Help > Guida rapida. Quest’ultima non è che un elenco delle 

informazioni circa il funzionamento delle opzioni e dei ialoghi. 
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3.4 Assistente 

Quando si crea un nuovo progetto, si dispone della possibilità di usufruire di un assistente, 

che genera i dati necessari a descrivere la paratia a partire da un numero ridotto di 

parametri inseriti in modo sequenziale. Tramite esso è possibile eseguire il 

predimensionamento della geometria e generare i carichi. Si può controllare e/o 

modificare qualsiasi dato inserito una volta generato il progetto. 

3.5 Elenchi 

Gli elenchi possono essere ottenuti mediante l’opzione File > Stampare > Elenchi del 

progetto o, alternativamente, cliccando sull’icona  ubicata nell’angolo superiore destro 

della barra degli strumenti. 

È inoltre possibile inviarli alla stampante (con anteprima di stampa opzionale, 

impostazione di pagina, ecc.), oppure esportarli in formato HTML, PDF, TXT, RTF e DOCX. 

 

Fig. 22 
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3.6 Disegni esecutivi 

I disegni esecutivi si ottengono tramite l’opzione File > Stampare > Disegni esecutivi del 

progetto o, alternativamente, cliccando sull’icona  ubicata nell’angolo superiore destro 

della barra degli strumenti. 

Si possono effettuare le seguenti operazioni inerenti ai disegni esecutivi: 

 La finestra Selezione di disegni esecutivi (Fig. 23) consente di aggiungere uno o più 

disegni esecutivi da stampare contemporaneamente e di specificare la periferica di 

output (stampante, plotter, DXF o DWG), di selezionare un cartiglio (di CYPE o qualsiasi 

altro definito dall’utente) e di configurare i layer. 

 

Fig. 23 

 

 In ogni disegno esecutivo è possibile configurare gli elementi da stampare, con la 

possibilità di includere dettagli forniti dall’utente importati in precedenza. 

 

Fig. 24 
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 Modificare la posizione di testi. 

 

Fig. 25 

 Collocare nuovamente gli oggetti all’interno dello stesso disegno esecutivo o spostarli 

in un altro. 

 

Fig. 26 
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